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17. Introduction – System Commands 

Through the System Commands Menu, access is given to several programs which 
allow passwords to be established and changed, data files to be restored, program 
updates to be installed and several other system functions to be performed. 

Below is a brief summary of all programs available from the System Commands Menu: 

Restore Data Files allows data files to be restored back onto the hard drive. 

Format Diskette allows floppy diskettes to be formatted for backing up data files. 

Install Program Updates allows program updates to be loaded onto the system via a CD-ROM or 
through the internet. 

System Status allows the next invoice, receipt, control or purchase order number to be 
reset and displays the number of free system records available. 

File Checking Functions allows integrity checks to be performed on the inventory file. 

Update Customer Name File updates the customer name searching index file with any additions or 
modifications to the customer file. 

Modify Menu & Password 
Security 

permits new security levels to be created, passwords modified and total 
program access for an employee (setup by management). 

Format Point of Sale Screen & 
Invoice 

allows management to setup the point of sale workspace screen and 
invoice format to meet the needs of their particular industry and 
business. 

Specify System Setup Options allows management to set specific store wide options, user variable 
options (by program) and default values for daily sales analysis and 
month end processing reporting. 

Specify Invoice/Statement 
Message Field 

allows a different invoice message of up to 5 lines (70 characters) to be 
created and stored for each invoice printer; allows a different statement 
message for customers with past due balances within 30, 60, and 90 day 
columns. 

Set System Clock allows the time and date of the system clock to be changed. 

Mount/Unmount CDROM allows the user to mount or unmount a CD ROM disk. 

Validate Programs allows the user to validate the programs that should be on the 
displayed build number.  If there are discrepancies, the build number 
will be displayed with an “X” after it on the menus. 

Import/Export Autologue 
System Data 

allows the user to import previously exported data from tape into their 
system or export their data onto a backup tape. 

 

This chapter of the User’s Manual will aid and instruct in the correct method of 
using each of the programs described above. 

17.1 Accessing The System Commands Menu 

• From the Autologue Main Menu, enter 13 (System Commands) and press <Return>. 
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The System Commands Menu will now be displayed as shown: 

 

 

• From the System Commands Menu, enter the number of the menu option to be accessed 
and press <Return>. 

• Press the F11 (Exit) key to return to the Autologue Main Menu. 

17.2 Restore Data Files 

The Restore Data Files menu option allows the user to restore a backup copy of the 
data files in case of a system or hardware failure.  Data can be restored from either 
floppy diskettes or a magnetic tape.  This process should only be performed with 
ALL other terminals at the login: prompt and should only be done after consulting 
with an Autologue Customer Service Representative! 

17.2.1 Performing The Restore 

• From the System Commands Menu, enter 1 (Restore Data Files) and press <Return>. 

The screen will clear and the system will check for any users that are still logged on. 
If there are users still logged in, they will be displayed.  Otherwise an All terminals 
are logged off message will be displayed. 

• With the cursor now positioned next to the For TAPE Restore type 't' - 
For DISK Restore type 'd': prompt, enter t or d and press <Return>. 

• With the cursor now positioned next to the What specific directories? 
<RETURN> for all: prompt, enter the specific directory (i.e. /usr/STR2) to only 
be restored or press <Return> to have all directories restored. 
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• With the cursor now positioned next to the Clear All Workspaces ? (y/n) 
prompt, enter y or n and press <Return>. 

Normally a y should be entered in order to remove all open workspaces and special 
orders! 

The screen will now display a warning message as shown: 

 

 

• With the cursor now positioned next to the Are you sure ? prompt, enter y or n 
and press <Return>. 

• With the cursor now positioned at either the PUT TAPE IN DRIVE AND TYPE 
‘y’ to PROCEED: or PUT DISK IN DRIVE AND TYPE ‘y’ to PROCEED: 
prompt, insert the tape or diskette into the correct drive, enter y and press 
<Return>. 

The data files will now be restored from the magnetic tape/floppy diskettes. As the 
data files are restored, the screen will display the size of each file in bytes and tape 
blocks. 

If additional diskettes are required, the program will prompt tar:  please 
insert next tape/disk;  then type 'y <Return>'. 

• Once all files are restored, press the <Return> key to return to the System Commands 
Menu. 

17.3 Format Diskette 

The Format Diskette menu option allows the user to prepare floppy diskettes to be 

used for backing up data files or programs.  Autologue recommends using 3M 
double sided - high density diskettes. 
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17.3.1 Performing The Format 

• From the System Commands Menu, enter 2 (Format Diskette) and press <Return>. 

• With the cursor positioned at the Insert floppy in drive;  press 
<Return> when ready prompt, insert a blank diskette into the drive and press 
<Return>. 

The system will now display the following as the diskette is being formatted: 

 

 

When the formatting process is completed, the screen will return to the System 
Commands Menu. 

17.4 Install Program Updates 

The Install Program Updates menu option allows the user to install program updates 
that are released as new and improved programs are developed.  Occasionally, the 
installation of program updates will require some assistance from an Autologue 
Customer Service Representative.  In such cases, a letter will be sent advising of such 
a need. 

17.4.1 Installing A Program Update 

� Note: Before installing updates, all terminals MUST first be at the login: prompt! 

• From the System Commands Menu, enter 3 (Install Program Updates) and press 
<Return>. 
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The Install Program Updates screen will now be displayed as shown: 

 

 

• With the cursor now positioned at the Type your choice and press 
<Return> prompt, enter 1, 2 or 3 and press <Return>. 

17.4.1.1 Installing New Programs From CD-ROM 

• With the cursor now positioned at the Type your choice and press 
<Return> prompt, enter 2 (Install new programs from CD-ROM) and press 
<Return>. 
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The screen will now display: 

 

 

• With the cursor now positioned at the Are all terminals at login (Y/N) 
prompt, enter Y and press <Return>. 

The installation process will begin and once all programs are installed, the screen 
will display a status report. 

• Press the Q (quit) key and screen will then build a validation database and then 
return to the System Commands Menu. 

17.4.1.2 Installing New Programs From The Internet 

• With the cursor now positioned at the Type your choice and press 
<Return> prompt, enter 3 (Install new programs from the Internet) and press 
<Return>. 

• With the cursor now positioned at the Are all terminals at login (Y/N) 
prompt, enter Y and press <Return>. 
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The screen will begin downloading the programs from the internet as shown: 

 

 

Once the downloading process is completed, the installation process will begin and 
once all programs are installed, the screen will display a status report. 

• Press the Q (quit) key and screen will then build a validation database and then 
return to the System Commands Menu. 

17.5 System Status 

The System Status menu option allows the user to view/edit the next invoice, receipt, 
control and purchase order number.  It also displays the total number of system 
records available and the current system time. 

� Note: The highest invoice number is 65,535 and the highest purchase order 
number is 32,767! 

17.5.1 Changing The Next Invoice Number 

� Note: Before changing, all terminals MUST first be at the login: prompt! 

• From the System Commands Menu, enter 4 (System Status) and press <Return>. 
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The System Status screen be displayed along with the next invoice number as shown: 

 

 

• With the cursor positioned at the ENTER <CR> OR A NUMBER TO SET IT TO 
prompt, press <Return> (to leave the next invoice number unchanged) or enter a 
number (between 1 - 65535) and press <Return> (to set the next invoice number to 
the number entered). 

The next receipt number will then be displayed. 

17.5.2 Changing The Receipt Number 

• With the cursor positioned at the ENTER <CR> OR A NUMBER TO SET IT TO 
prompt, press <Return> (to leave the next receipt number unchanged) or enter a 
number (between 1 - 99999) and press <Return> (to set the next receipt number to 
the number entered). 

The next control number will then be displayed. 

17.5.3 Changing The Control Number 

• With the cursor positioned at the ENTER <CR> OR A NUMBER TO SET IT TO 
prompt, press <Return> (to leave the next control number unchanged) or enter a 
number (negative number or positive between 1 - 65535) and press <Return> (to set 
the next control number to the number entered). 

By default, the number is set for 0 which will roll over to 1, 2, etc., once the invoice 
numbers have rolled over.  User’s have ability to set a static number to always print 
at the end of invoice number by entering a negative value such as -1 for store 1 or -2 
for a store 2.  The next purchase order number will then be displayed. 
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17.5.4 Changing The Purchase Order Number 

• With the cursor positioned at the ENTER <CR> OR A NUMBER TO SET IT TO 
prompt, press <Return> (to leave the purchase order number unchanged) or enter a 
number and press <Return>. 

• With the cursor positioned at the ENTER <CR> OR A NUMBER TO SET IT TO 
prompt, press <Return> (to leave the next purchase order number unchanged) or 
enter a number (between 1 - 32767) and press <Return> (to set the next purchase 
order number to the number entered). 

The screen will then display an N SYSTEM RECORDS ARE AVAILABLE message.  
This information is useful for the Autologue Customer Service Department when 
needing to find out this information! 

• Press the <F11> (Exit Pgm) or <Return> key to return to the System Commands 
Menu. 

17.6 File Checking Functions 

The File Checking Functions menu option allows the integrity of the Inventory file to 
be reviewed by management without the aid of an Autologue Customer Service 
Representative.  The integrity of the Inventory file should be checked at least once a 
month (normally a few days before month end). 

� Note: All functions on the File Checking Menu should only be performed with all 
terminals at the login: prompt! 

17.6.1 Product Line Check 

The Run Product Line Check menu option scans the Inventory file for unconnected or 
tangled part number records.  This process can take from 15 minutes to two hours in 
order to complete (depending on the Inventory file size). 

Listed below are the steps for running a product line check: 

• From the System Commands Menu, enter 5 (File Checking Functions) and press 
<Return>. 
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The File Checking Menu will now be displayed as shown: 

 

 

• From the File Checking Menu, enter 1 (Run Product Line Check) and press <Return>. 

The screen will display a PRODUCT LINE CHECK IN PROGRESS message and will 
return to the File Checking Menu when completed. 

• To review the results of the check, enter 2 (View Product Line Check) or 3 (Print 
Product Line Check) from the File Checking Menu and press <Return>. 

Entering 2 will display the results on the screen.  Press the <Space Bar> to display 
additional information.  Press Q to return to the File Checking Menu. 

Entering 3 will print the results on the management printer.  The screen will 
automatically return to the File Checking Menu. 

� If the product line check reported errors, contact the Autologue Customer Service 
Department as soon as possible to fix the reported errors because the month end 
processing could fail if there database corruption within the Inventory file. 

• Press the F11 (Exit) key to return to the System Commands Menu. 

17.6.2 Inventory Hash Count Check 

The Run Inventory Hash Count Check menu option scans the Inventory file for 
collision counts and dead records.  This process can take from 15 to 45 minutes in 
order to complete (depending on the Inventory file size). 

Listed below are the steps for running an inventory hash count check: 

• From the System Commands Menu, enter 5 (File Checking Functions) and press 
<Return>. 
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• From the File Checking Menu, enter 4 (Run Inventory Hash Count Check) and press 
<Return>. 

The screen will display an INVENTORY HASH COUNTER CHECK IN PROGRESS 
message and will return to the File Checking Menu when completed. 

• To review the results of the check, enter 5 (View Inventory Hash Count Check) or 6 
(Print Inventory Hash Count Check) from the File Checking Menu and press <Return>. 

Entering 5 will display the results on the screen.  Press the <Space Bar> to display 
additional information.  Press Q to return to the File Checking Menu. 

Entering 6 will print the results on the management printer.  The screen will 
automatically return to the File Checking Menu. 

� If the inventory hash count check reported errors, contact the Autologue Customer 
Service Department as soon as possible to fix the reported errors because this can 
cause the system to become slow in calling up certain part numbers within point 
of sale. 

• Press the F11 (Exit) key to return to the System Commands Menu. 

17.7 Update Customer Name File 

The Update Customer Name File menu option creates a customer name search index 
file based upon the information within the Customer/Vendor file.  This program 
should be run whenever a name change has been made to an existing customer, a 
customer number has been renumbered, or a new customer has been entered into 
the system! 

From Point of Sale, Customer/Vendor Update and Purchasing, the customer name 
search index file allows user’s to enter in a customer or vendor’s name and have the 
system display a selection list to choose from. 

17.7.1 Updating The Customer Name File 

• From the System Commands Menu, enter 6 (Update Customer Name File) and press 
<Return>. 

The screen will clear and display a GENERATING NAME LIST message as the 
customer name search index file is being created.  Upon completion, a NAME LIST 
COMPLETE message will be displayed and the screen will return to the System 
Commands Menu. 

17.8 Modify Menu & Password Security 

The Modify Menu & Password Security menu option allows new and existing logins 
and passwords to be created, reviewed and modified.  Eight logins come standard 
with each system: admin, root, inv, book, pos, spo, counter and utl.  Other logins 
also come standard with the system when the multi-store, bill of materials, 
accounting or word processing software has been purchased. 
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Management has the ability to add additional logins to the system for specific users 
and can customize each user’s access into specific menus.  Existing logins can also be 
reviewed and/or modified.  A password can also be changed for an existing login. 

17.8.1 Creating A New User Login 

To quickly create a new login, specifically for a user, and setup specific menu 
options in which they have access to, follow the steps below: 

• From the System Commands Menu, enter 7 (Modify Menu & Password Security) and 
press <Return>. 

The User Update Program screen will now be displayed as shown: 

 

 

• Press the <F1> (Create New User) key 

• With the cursor positioned at the ENTER NAME TO ADD prompt, enter the new 
login name and press <Return>. 

� Note: Login names must be at least three characters long and begin with a letter! 

17.8.1.1 Setting Up A Login For Complete Menu Access 

• With the cursor positioned at the PERMIT ACCESS TO ENTIRE SYSTEM prompt, 
enter Y and press <Return>. 

This will permit access to all programs for the newly created login.  The screen will 
then prompt for a password.  To enter a password, enter a password and press 
<Return>.  The screen will prompt to re-type the same password.  Again enter the 
password and press <Return>.  To not enter a password, simply press <Return>.  
The screen will then return to the User Update Program screen. 
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17.8.1.2 Setting Up A Login With Limited Menu Access 

• With the cursor positioned at the PERMIT ACCESS TO ENTIRE SYSTEM prompt, 
enter N and press <Return>. 

The screen will now display a Menu Selection screen as shown: 

 

 

From this menu, management can specify by menu or sub-menu, the specific menu 
options the user can or cannot access. 

• With the cursor positioned at the ENTER A NUMBER: prompt, enter the number of 
the menu to be reviewed/updated and press <Return>. 
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If 1 (Main Menu) was entered, the Autologue Main Menu screen will then be displayed 
as shown: 

 

 

If 2 (Report Processing) was entered, the Report Processing Menu screen will then be 
displayed as shown: 
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If 3 (SYSTEM COMMANDS) was entered, the System Commands screen will then be 
displayed as shown: 

 

 

If 4 (MISCELLANEOUS FUNCTIONS) was entered, the Miscellaneous Functions Menu 
screen will then be displayed as shown: 
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If 5 (MULTI-STORE FUNCTIONS) was entered, the Multi-Store Functions Menu 
screen will then be displayed as shown: 

 

 

If 6 (W/D TRANSMISSION FUNCTIONS) was entered, the W/D Transmission 
Functions Menu screen will then be displayed as shown: 
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If 7 (PRICE UPDATING) was entered, the Price Updating Menu screen will then be 
displayed as shown: 

 

 

If 8 (TRACKING FUNCTIONS) was entered, the Tracking Menu screen will then be 
displayed as shown: 

 

 

• With the cursor positioned at the PERMIT ALL ? prompt, enter Y and press 
<Return> to allow access to each menu option or enter N and press <Return> to 
have the cursor positioned on the first menu option. 
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• Enter Y or N at each menu option, press <Return> and then press the <F10> (Save 
This Menu) key to create and save all entered information for each menu. 

• Once all menu options are set, press the <F10> (Saves Login Entry) key to create and 
save all entered information for each menu for the new login. 

The screen will then prompt for a password.  To enter a password, enter the 
password and press <Return>.  The screen will prompt to re-type the same 
password.  Again enter the password and press <Return>.  To not enter a 
password, simply press <Return>.  The screen will then return to the User Update 
Program screen. 

• Press the F11 (Exit) key to return to the System Commands Menu. 

17.8.2 Reviewing/Changing A Login’s Menu Access 

Reviewing an existing login’s menu access is easily performed through the use of the 
<F5> (Review/Change A Login’s Permissions) function key.  While reviewing an 
existing login’s menu access, changes may be performed on menu option access 
and/or the login’s password.  Login’s can be created for individuals, departments or 
job titles.  Up to 30 login’s and passwords can be maintained at one time. 

To quickly review or change a login’s menu access, follow the steps below: 

• From the System Commands Menu, enter 7 (Modify Menu & Password Security) and 
press <Return>. 

• From the User Update Program screen, press the <F5> (Review/Change A Login’s 
Permissions) key. 

• With the cursor positioned at the ENTER NAME TO CHANGE prompt, enter the login 
name to be reviewed or changed and press <Return>. 

• With the cursor positioned at the CHANGE PASSWORD? (Y/N) prompt, enter Y or N 
and press <Return>. 

When Y is entered, the screen will then prompt for a new password.  Enter in a new 
password and press <Return>.  For security reasons the new password will not be 
displayed on the screen as its being entered!  The screen will prompt to re-type the 
same password.  Again enter the password and press <Return> to complete 
changing the password and return to the User Update Program screen. 

When N is entered, the cursor will then be positioned at the PERMIT ACCESS TO 
ENTIRE SYSTEM? (Y/N) prompt. 

• With the cursor positioned at the PERMIT ACCESS TO ENTIRE SYSTEM? (Y/N) 
prompt, enter Y or N and press <Return>. 

When Y is entered, this allows the login to access all menu options from the main 
menu, including the ability to create and change new security levels and change 
passwords.  The screen will display an update message and return to the User Update 
Program screen. 



Autologue User’s Manual – System Commands Page 19 

 

 

When N is entered, the screen will now display a Menu Selection screen that allows 
the user to selectively set menu option access by menu as previously described.  The 
screen will display an update message and return to the User Update Program screen 
when the <F10> (Save Login Entry) key is pressed. 

17.8.3 Changing Passwords 

Passwords can be added or changed at any time as often as desired.  Passwords can 
only be changed by login’s with access to the Modify Menu & Password Security menu 
option. 

To change or create a new password, follow the steps below: 

• From the System Commands Menu, enter 7 (Modify Menu & Password Security) and 
press <Return>. 

• From the User Update Program screen, press the <F5> (Review/Change A Login’s 
Permissions) key. 

• With the cursor positioned at the ENTER NAME TO CHANGE prompt, enter the login 
name to be reviewed or changed and press <Return>. 

• With the cursor positioned at the CHANGE PASSWORD? (Y/N) prompt, enter Y and 
press <Return>. 

When Y is entered, the screen will then prompt for a new password.  Enter in a new 
password and press <Return>.  For security reasons the new password will not be 
displayed on the screen as its being entered!  The screen will prompt to re-type the 
same password.  Again enter the password and press <Return> to complete 
changing the password and return to the User Update Program screen. 

17.9 Format Point Of Sale Screen & Invoice 

The Format Point Of Sale Screen & Invoice menu option allows the user to modify the 
order and/or omit various fields of information from the point of sale workspace 
screen and printed invoice.  The order of fields can be changed so that the part 
number and quantity fields are positioned next to each other or to have the core 
price field omitted from being displayed or printed when a companies part numbers 
don’t having core values. 

To change the point of sale screen or invoice, follow the steps below: 

• From the System Commands Menu, enter 8 (Format Point Of Sale Screen & Invoice) and 
press <Return>. 
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The Specify Workspace and Invoice Format screen will then be displayed as shown: 

 

 

• Using the arrow keys, position the cursor within the field to be changed, enter the 
new field width or rearrange the order and press <Return>. 

Note: A help screen is available by pressing the <F8> (Help) key.  When the <F8> 
key is pressed, a window will be displayed on the lower portion of the screen.  To 
have the help screen “zoom” to a full screen of help, press the letter z key.  The 
available field codes are listed within the help screen.  Non-standard fields such as 
quantity on hand, quantity ordered, quantity shipped, quantity backordered and 
zone bin can be setup for viewing within the workspace screen or printing on the 
invoice.  Press the <Return> or F11 (Exit) to exit the help screen. 

• Once all entered changes are completed, press the <F10> (Save Changes) key to save 
the new invoice and workspace formats and the cursor will return to the first field. 

• Press the F11 (Exit) key to return to the System Commands Menu. 

17.10 Specify System Setup Options 

The Specify System Setup Options menu option allows the user to perform the 
following functions: 

♦ Activate or deactivate the various uservar (user variable) options available 
throughout the system (without the assistance of customer service!) 

♦ Easy password setting for the various program specific passwords available within 
the system! 

♦ Activate or deactivate the various standard point of sale setup options! 

♦ Setting the default values for month end processing and daily sales analysis screens! 
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When setting uservar options within the editor, each option can be retrieved by 
program section (i.e. pos, pur) and a detailed description is also displayed for each 
option available! 

� Note: This program must be run with all other terminals at the login: prompt.  Any 
terminals not at the login: prompt will not reflect the changes made and will 
reflect the old options until they are logged off and logged back in again! 

17.10.1 Accessing The Specify System Setup Options 

• From the System Commands Menu, enter 9 (Specify System Setup Options) and press 
<Return>. 

The Autologue System Configuration Files Menu will now be displayed as shown: 

 

 

17.10.2 Common Keystrokes 

All elements of the Autologue System Configuration Files Menu have several keystrokes 
in common. 

Keys Explanation 

������������ arrow keys: Used to go from side to side or up and down choice lists as they are presented. 

<F10> key: Used to save changes. 

<F11> key: Exits or quits from the section of the program the user is currently in at the 
time. 

First Letter Rule: Selects a menu item on any menu, thus by-passing the need to use the arrow 
and <Return> key combinations! Also quickly positions the cursor on a choice 
list selection by entering the first letter of the item. 

<Page> and <Shift> & 
<Page> 

Used to scroll forward/backward through selection lists. 
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There are three (3) exceptions to the first letter rule, these are the file list choice list 
and the uservar choice lists.  The file lists require the user to use the arrow and 
<Return> key combinations to select a file.  The SECTION and USERVAR choice 
lists allow user’s to enter the first letter (to move closer to the item to be selected) and 
thus reduce the time spent in trying to get to a certain area. 

Example: 

To get to the (P) PIT, POS, etc., area of the SECTION choice list, enter P to have the 
cursor quickly position itself on the first entry starting with the letter ‘P’, then use the 
arrow keys to move around the list from there.  Press the <Return> key to select the 
choice.  When there are long choice lists, the <Page> and <Shift> & <Page> keys 
are used to scroll forward/backward through a list. 

17.10.3 The Autologue System Configuration Files Menu Screen 

The line on the screen (File Options Dsa Mroll Quit) is where the main functionality 
of the program is performed.  Use the ��� arrow keys to move the cursor to 
each menu option or simply press the first letter of the desired menu selection to 
automatically select it. 

Example: pressing the letter D will automatically select the Dsa menu selection! 

Here is a brief overview of the menu selections: 

File used to access the uservar and password files; This function allows 
user’s to view/change uservar settings and password settings for the 
system; 

Options used to enable/disable the standard point of sale/multi-store system 
settings; 

Dsa used to set the Daily Sales Analysis screen defaults; 

Mroll used to set the Month End Processing screen defaults; 

 

The program has been designed to provide the greatest flexibility and ease of use for 
user’s who want to “customize” their system without the assistance of customer 
service! 

17.10.4 Using The File Feature 

The File menu option is the most complex feature of the program and there is a lot 
to explain.  The best way to understand how it works is to follow an example all the 
way through.  As we go through the example, we’ll try to use as many elements as 
possible.  A quick reference will be provided at the end as well as some short cuts to 
conserve time. 

This option is used to insert, change and monitor uservar options and system 
passwords.  When the File menu option is selected, a drop down selection list is 
presented with four selections (Open Edit Write Quit).  The Open menu 
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selection presents the user with a list of two file names from which to choose 
(uservar & passwd.db).  The uservar option is the file that contains all the 
different user variable settings/features that can be customized for the various 
programs on the system.  The passwd.db is the file that contains passwords for 
protected features of the system. 

� Due to the sensitive nature of this information, it’s recommended that this area of 
the system be password protected within the menu screens! 

Each of the four selections, within the File menu drop down selection list, will 
display a short message at the bottom of the screen: 

Open Select a Configuration File for Editing 
Edit Edit Previously Opened File; Note: if no file has been opened, this option will 

default to the uservar file! 
Write Write a Modified File 
Quit Exit the File Menu; Stays in the configuration editor; 

 

• Within the File menu drop down selection list, select Open by positioning the cursor 
on the selection using the arrow keys and pressing <Return> or by pressing the 
letter O key. 

• Within the File Name: selection window, select uservar by positioning the cursor 
on the selection using the arrow keys and pressing <Return>. 

The screen will now display the User Variable Editor screen and the cursor will 
positioned within a Section window selection list as shown: 

 

 

The selections within Section window are the major “sections” of the uservar file 
broken up for easy access.  All uservar’s relating to a section will be presented when 
a choice is made from this list. 
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Example: 

Enter the letter P and the cursor will automatically be positioned on the first 
selection within the list that starts with the letter P (PIT).  Now press the � arrow 
key and press <Return> to select the POS section. 

The screen will now display a selection list of uservar options available for the 
selected Section as shown: 

 

 

These are all the uservar’s associated with the point of sale program. 

• Select the DISPLAYMM uservar by entering the letter D, the cursor will automatically 
be positioned on the DISPLAYMM uservar, and press <Return>. 

� Note: The ����, ����, <Page> and <Shift> & <Page> keys can be used to peruse the list 
of available uservar’s! 
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The screen will now display all information for the DISPLAYMM uservar option as 
shown: 

 

 

17.10.5 The User Variable Editor Screen 

The top of the User Variable Editor screen shows the version of the program, the title 
and the file name currently being editing. 

Section the area of the file currently being processed 
Uservar the specific uservar option being edited 
Value shows what the uservar is set to 
Default shows what the uservar value defaults to 
Status shows if the uservar option is Active or iNactive on the system; If set iNactive, this 

means it has no effect on the system operation; Active means the system uses this 
option 

Type shows what “TYPE” of uservar this is (used for data validation only in this screen) 
 Number: (digits only) 0, 1, 2, etc.,. 
 String: (characters/letters only) A, a, B, c, d, e, F, etc.,. 
 Part: Autologue part number only 
 Alpha-numeric: (numbers and letters) A, 4, 3, f, etc.,. 
 Customer: used only in the password file for customer field passwords 
Range shows the value range that is legal for this uservar 
 0 TO 1: means only 0 or 1 can be entered in the value field 
 Aa - Zz: means only letters (capitals or lower case) from A to Z can be 

entered 
 B or S: means only those two letters are allowed, etc.,. 
Description explains a little bit about this uservar, what it does or what it can do for or to the 

system. 
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Example: 

The information for the DISPLAYMM uservar option says it will display the min/max 
fields for a part when the <F3> (Inventory Override) key is pressed within point of 
sale. 

The bottom box on the screen shows all the available function keys and what they 
do. 

F1: Find finds a uservar; pops up a choice list of every uservar available 
F2: Insert/Add inserts or adds a uservar; used only when adding a new uservar or password to the 

list.  This will show the edit screen with blanks in all the fields.  User’s must enter a 
value for each field; this feature is intended for convenience in the event that a 
uservar needs to be added for some reason; should be used with the assistance of a 
customer service representative the first time through at least! 

F3: Activate/Edit activate or edit a uservar; allows user’s to activate a uservar on their system and 
change the values seen on the screen for that uservar. 

F4: Deactivate deactivates a uservar; allows user’s to set this as inactive and not used by the 
system. 

F5: Section section; pops up the section list to go to a new section of the uservar’s. 
F6: First displays the first uservar in the list without using the Section or Uservar selection 

lists. 
F7: Last displays the very last uservar in the list without using the Section or Uservar 

selection lists. 
F8: Next displays the next uservar in the list in alphabetic order, NOT in section order! 
F9: Previous displays the previous uservar in the list in alphabetic order, NOT in section order! 
F10: Save saves whatever changes were made to the uservar entry IN MEMORY! This key 

DOES NOT WRITE OUT THE FILE! To save changes to the file so that the system 
will use this option, USER’S MUST USE THE WRITE FUNCTION in the file menu! 
Displays a pop up window prompting if you are sure you want to save the changes 

in memory Y or N, if sure, enter Y, press <Return> and the changes will be 
saved in memory.  This is insurance for user’s to guard against accidental changes 
being written out to the file when this is not what they really want! Remember: 
each of these settings affects the way the system operates and care should be 
exercised when making changes to the uservar files! When in doubt DON’T! 

Mode at the very bottom of the screen is a field labeled Mode; this tells what MODE 
user’s are operating in at the moment. 

 READ means user’s are just reading the file and no changes can be 
made in this mode; this is the default mode of operation. 

 EDIT means changes can be made to the values on the screen and can 

only be activated by pressing the <F3> (Activate/Edit) key. 
 INSERT the mode used when adding or entering a new uservar. 

 
� Note: If the user find himself in a mode and isn’t sure how they got there or the 

editor is not behaving as expected, DON’T PANIC just use the <F11> key to exit.  
If it asks to save changes just enter No and no harm is done!  The editor is 
designed to be as safe as possible to protect the system. 
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17.10.6 Activating A Uservar 

The great majority of the time the editor will be used to activate or deactivate a 
uservar that is in the list or just go through the uservar’s to see what is available to 
enhance the system operation.  The editor can effectively be used with just a few 
keystrokes like the following examples: 

17.10.6.1 Example: Activating The DISPLAYMM Uservar Option 

1. File menu F or <Return> if the cursor is on the File menu option 

2. <Return> on the Open menu option or E to skip step #3 

3. <Return> when the cursor is positioned on the uservar option 

4. P to go to the P’s section, press � to POS and <Return> 

5. D to go to the D’s section, press <Return> on the DISPLAYMM uservar option 

6. <F3> (Activate) 

7. <F10> (Save) 

8. Y and <Return> 

9. F11 (Quit) 

10. W (Write) and <Return> on the uservar file name 

11. Y and <Return> 

12. F11 (Quit) done! 

17.10.6.2 Example: Deactivating The DEFQOH Uservar Option 

1. File menu F or <Return> if the cursor is on the File menu option 

2. <Return> on the Open menu option or E to skip step #3 

3. <Return> when the cursor is positioned on the uservar option 

4. D to go to the DATAIU and <Return> 

5. <Return> on the DEFQOH uservar option 

6. <F4> (Deactivate) 

7. <F10> (Save) 

8. Y and <Return> 

9. F11 (Quit) 

10. W (Write) and <Return> on the uservar file name 

11. Y and <Return> 

12. F11 (Quit) done! 
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17.10.6.3 Example: Perusing The Uservar Options 

1. File menu F or <Return> if the cursor is on the File menu option 

2. <Return> on the Open menu option or E to skip step #3 

3. <Return> when the cursor is positioned on the uservar option 

4. <Return> and <Return> (yes, two returns in a row) 

5. From this point, the <F1> (Find), <F5> (Section), <F6> (First), <F7> (Last), <F8> 
(Next) and <F9> (Previous) keys can be used! 

6. F11 (Quit) done! 

17.10.6.4 Example: Insert Or Adding A Uservar Option 

For this example we will use the password file!  This example enters a password 
entry for customer file access level (field) 3: 

1. File menu F or <Return> if the cursor is on the File menu option 

2. <Return> on the Open menu option 

3. � to passwd.db and <Return> 

4. <Return> and <Return> 

5. <F2> (Insert/Add) 

6. With the cursor now positioned at the Section field, enter CUST or USERADD and 
press <Return>.  Note: this field is designed to accept any entry, but users should 
try to enter an existing section name unless a specific purpose is in mind. 

7. With the cursor now positioned at the Uservar field, enter CUS_FLD3 and press 
<Return>.  Again this field will accept any entry, but an unknown uservar or 
password entry will not do anything unless the programs know about it! Questions 
concerning valid entries must be resolved before entry into the system. 

8. With the cursor now under the Value field, enter the values and press <Return>.  
This type of entry is a C (Customer) type, valid entries are: numbers ( 0...486), commas 
(,) & dashes (-); 22-40,45 means this field level password can change entries on the 
customer screen for fields 22 through 40 and 45 only! 

9. With the cursor now under the Default field, enter the default values and press 
<Return>.  (Use the same values that were entered into the Value field). 

10. With the cursor now positioned within the Type drop down selection box, arrow 
down to the C (Customer) type and press <Return>. 

11. With the cursor now positioned at the Range field, enter 0 press <Return> and 
enter 486 press <Return>. 

12. <F10> (Save) 

13. Y and <Return> 

14. F11 (Quit) Note: since this is a user added field, entry in other fields is not required 
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17.10.7 Using The Options Feature 

This option is used to set the standard point of sale and multi-store options for the 
system.  Each question can be answered with a Y or N response.  To enter a response, 
simply enter Y or N and press <Return> with the cursor positioned on the question.  
Use the � and � arrow keys to position the cursor on the question to be changed.  
Once all questions have been changed, press the <F10> key (to save the answers).  
Users must save the screen (F10) in order for the settings to take affect!  Pressing 
the <F11> key at any time will exit the screen (whether the changes have or have not 
been saved).  When the <F10> key is pressed to save changes, the program will 
prompt Save Changes... Are You Sure? Enter Y or N and press <Return> to save or not 
save the settings. 

17.10.8 Using The Dsa Feature 

This option is used to set the Daily Sales Analysis reporting defaults.  Each question 
can be answered with a Y or N response except for the BEGINNING & ENDING 
COUNTERMAN questions.  These questions require the user to enter a capital letter 
or number for the counterman code that represents the beginning counterman code 
and the ending counterman codes.  To enter a response, simply enter Y or N and 
press <Return> with the cursor positioned on the question.  Use the � and � arrow 
keys to position the cursor on the question to be changed.  Once all questions have 
been changed, press the <F10> key (to save the answers).  Users must save the 

screen (F10) in order for the settings to take affect!  Pressing the <F11> key at any 
time will exit the screen (whether the changes have or have not been saved).  When 
the <F10> key is pressed to save changes, the program will prompt Save Changes... 
Are You Sure?  Enter Y or N and press <Return> to save or not save the settings. 

17.10.9 Using The Mroll Feature 

This option is used to set the Month End Processing reporting defaults.  It works just 
like the Dsa feature described. 

17.10.10 Using The Quit Feature 

This option is used to exit from the ACS System Configuration Files Menu screen and 
return to the System Commands menu.  Pressing the <F11> key from the ACS System 
Configuration Files Menu will also exit! 



Autologue User’s Manual – System Commands Page 30 

 

 

17.11 Specify Invoice/Statement Message Field 

The Specify Invoice/Statement Message Field menu option allows the user to create 
and/or change an invoice or statement message for each invoice/report printer.  The 
message field can store up to five lines, of seventy characters per line, of store and 
sale information.  The invoice message field is a great way of listing store hours, 
return policies and current sale items. Additionally, users can create/edit an invoice 
footer message for laser formatted invoice printers. The invoice footer field is 
normally used to enter in any disclaimer information that prints on the lower left 
hand portion of the laser formatted invoice. 

17.11.1 Creating An Invoice Message 

• From the System Commands menu, enter 10 (Specify Invoice/Statement Message Field) 
and press <Return>. 

The Create Invoice/Statement Message screen will now be displayed as shown: 

 

 

• With the cursor positioned next to the Create/Modify Message For:  (1) 
Invoice (2) Statement (3)Footer prompt, enter 1 and press <Return>. 

• With the cursor positioned next to the Printer Number: prompt, enter the 
number of the printer number to create/modify a message for and press <Return>. 

• With the cursor positioned on the first line of the invoice message field, enter the 
first line of information and press <Return>. 

• Continue entering the new message and press the <F10> (Save Message) key to save 
the entered message. 
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• With the cursor positioned next to the Save new invoice/statement message 
(Y/N)? prompt, press <Return> (to use the default value of Y) to save the entered 
message information. 

The screen will then return to the System Commands menu. 

17.11.2 Creating A Statement Message 

• From the System Commands menu, enter 10 (Specify Invoice/Statement Message Field) 
and press <Return>. 

• With the cursor positioned next to the Create/Modify Message For:  (1) 
Invoice (2) Statement (3)Footer prompt, enter 2 and press <Return>. 

• With the cursor positioned next to the Days Of Outstanding: (1) Current 
(2) 30 Days (3) 60 Days (4) 90 Days (5) All prompt, enter the period 
to create a statement message for (1-5) and press <Return>. 

• With the cursor positioned on the first line of the invoice message field, enter the 
first line of information and press <Return>. 

• Continue entering the new message and press the <F10> (Save Message) key to save 
the entered message. 

• With the cursor positioned next to the Save new invoice/statement message 
(Y/N)? prompt, press <Return> (to use the default value of Y) to save the entered 
message information. 

The screen will then return to the System Commands menu. 

17.11.3 Creating An Invoice Footer Message 

• From the System Commands menu, enter 10 (Specify Invoice/Statement Message Field) 
and press <Return>. 

• With the cursor positioned next to the Create/Modify Message For:  (1) 
Invoice (2) Statement (3)Footer prompt, enter 3 and press <Return>. 

• With the cursor positioned next to the Printer Number: prompt, enter the 
number of the printer number to create/modify an invoice footer message for and 
press <Return>. 

• With the cursor positioned on the first line of the footer message field, enter the first 
line of information and press <Return>. 

• Continue entering the new message and press the <F10> (Save Message) key to save 
the entered message. 

• With the cursor positioned next to the Save new invoice/statement message 
(Y/N)? prompt, press <Return> (to use the default value of Y) to save the entered 
message information. 

The screen will then return to the System Commands menu. 
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17.11.3.1 Inserting A Complete Line 

• Using the arrow keys, position the cursor on the line where the line insertion is 
desired and press the <F5> key.  A blank line will be inserted at the current position 
and push all existing invoice/statement message information down. 

17.11.3.2 Modifying An Existing Invoice/Statement Message 

• Using the arrow keys, position the cursor within the text where the modifications 
will be made and overtype the existing text. 

Note: The <Home> key will position the cursor at the beginning of the line the cursor 
is currently positioned on and <Esc> e will position the cursor at the end of the line 
the cursor is currently positioned on. 

17.11.3.3 Reflowing An Existing Invoice/Statement Message 

• Press the <F4> (Reflow) key and the invoice/statement message information will be 
“Reflowed” (positioning as much text on each line as possible). 

17.11.3.4 Splitting A Line Within An Invoice/Statement Message 

• Using the arrow keys, position the cursor one position past the word where the line 
is to be split and press <Return>.  All information after the cursor will be 
repositioned on the next line. 

17.11.3.5 Deleting A Complete Line 

• Using the arrow keys, position the cursor on the line that is to be deleted and press 
the <F6> key.  The line will be deleted and the invoice/statement message 
information will be repositioned accordingly. 

17.11.3.6 Deleting A Word 

• Using the arrow keys, position the cursor one position past the word that is to be 
deleted and press the <Back Space> key.  Each time the <Back Space> key is 
pressed, the character to the left will be deleted. 

• When insertions, deletions, splitting of lines and reflowing actions are completed, 
press the <F10> (Save Message) key to save the modified message information. 

17.12 Set System Clock 

The Set System Clock menu option allows the user to set the system’s time and date. 
 

• From the System Commands Menu enter 11 (Set System Clock) and press <Return>. 
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The screen will now display the system’s current date and time as shown: 

 

 

• With the cursor positioned next to the Enter new time ([yymmdd]hhmm): 
prompt, press <Return> to leave the date and time unchanged or enter the date and 
in the format (yymmddhhmm) and press <Return>. 

 
Date/Time Format 

Characters 
Description 

yy the last 2 digits of the year 
mm the month of the year in digits 
dd the day of the month in digits 
hh the hour of the day (military time) 
mm the minutes of the hour 

 
The time should be entered based on “military time”. 

Examples: 

♦ November 17th, 2000 8:05 AM should be entered as 0011170805. 

♦ November 17th, 2000 4:30 PM should be entered as 0011171630. 
 

If the date and/or time are incorrectly entered, the screen will display a cvt: bad 
conversion message. 

• Enter the date and time (yymmddhhmm) or press <Return> to leave unchanged. 

Upon completion, the screen will return to the System Commands Menu. 
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17.13 Mount/Unmount CDROM 

The Mount/Unmount CDROM menu option allows the user to mount or unmount a 
CD ROM disk.  This is necessary when updating Part Select™ Cataloging or 
mounting a Parts Genie™  price updating CD ROM disk. 

17.13.1 Mounting & Unmounting A CDROM Disk 

• From the System Commands Menu, enter 12 (Mount/Unmount CDROM) and press 
<Return>. 

The Select the CDROM to mount/unmount screen will be displayed as shown: 

 

 

• With the cursor positioned on the first entry in the Select the CDROM to 
mount/unmount window, highlight the desired CD ROM menu selection to be 
mounted or unmounted by arrowing down to it and press <Return>. 

The <F11> (Exit) key can be pressed to exit without mounting or unmounting a CD 
ROM menu selection. 

If there is an M displayed to the far right of a CD ROM menu selection, this means 
that particular CD ROM is currently mounted.  Selecting the CD ROM menu 
selection will unmount the particular CD ROM menu selection.  The mounting 
process is the reverse of this. 

Once a CD ROM menu selection has been unmounted, eject the CD ROM disk from 
the drive and insert the new one to be mounted and close the drive door.  Mount the 
CD ROM drive as previously described. 

Upon completion, the screen will return to the System Commands Menu. 
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17.14 Validate Programs 

The Validate Programs menu option allows the user to validate the programs 
currently loaded on the system against what should be on the displayed build 
number. 

If there are discrepancies, a list of files will be displayed within a window.  The build 
number on the menus will then be displayed with an “X” after it. 

17.15 Import/Export Autologue System Data 

The Import/Export Autologue System Data menu option allows the user to import 
previously exported data from a backup tape into their system or export their 
existing data onto a backup tape. 

 


